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The Ohio Department of Education funds development of EMIS training materials
as part of the EMIS Alliance grant. There is an expectation that ITCs will utilize these
materials in training provided to your districts. That said, there are restrictions on
use of the EMIS Alliance materials as follows: Materials developed as part of the
EMIS Alliance program must be provided at no cost to your training participants. If
you utilize the EMIS Alliance training materials — in whole or in part — you must not
charge participants a fee to attend the class where the materials are used. Likewise,
you may not use the materials or any portion thereof in any event where a fee is
charged to attend. Exceptions must be approved in writing by the Department of
Education in advance of scheduling/promoting any event which may violate these
restrictions.

Questions regarding appropriate use of EMIS Alliance materials, or requests for
exception to the restrictions noted above, should be directed to Melissa Hennon
[Melissa.Hennon@education.ohio.gov].
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- Overview

* Teacher Licensure Course (TLC) Status Report

* Includes all courses reported to EMIS and the proper certification
status of the teacher of record

* |s generated for all EMIS reporting entities and updated nightly

» * |s used to provide data for Local Report Cards (LRC), certain state and
| federal funding, and for ODE program evaluation and planning

* This presentation will focus on troubleshooting the TLC Status
Report, which is generated during the Initial Staff and Course
(L) Collection
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. Certification Data on LRC

The LRC contains data from the Initial Staff and Course
Collection that is used to populate the school or district details

Your District's Teachers

Attendance Rate Average Salary Avg. Years of Experience Lead or Senior Teachers
94% $59,575 17 4

https://reportcard.education.ohio.gov

All Schoolsin | High Poverty = Low Powverty

the District Schools Schools
Percentage of teachers with at least a Bachelor's Degree 8.2 98.0 0.0
Percentage of teachers with at least a Master's Degree 454 448 0.0
Percentage of inexperienced teachers 6.1 6.5 0.0
Percentage of inexperienced principals 14.3 15.4 0.0
Percentage of teachers who are not teaching in the subject or field for which the teacheris 5.5 56
certified or licensed
Percentage of teachers teaching with temporary or conditional credentials 1.6 1.5
Adistrict's high poverty schools are those ranked in the top quartile based on the percentage of the district's economically disadvantaged students. EMIS
Low-poverty schools are those ranked in the bottom quartile based on the percentage of economically disadvantaged students. A district may have
\ buildings in both quartiles, in just one quartile, or in neither quartile.

| *N. .
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TLCS Data Uses

TLC data will also be used
* by the ODE Federal Programs Office to audit the use of Title | Funds

* to generate the ESSA State Licensure Assurances Report
e 20##L PRIN_ESSA_Licensure_Assurances_<file date>.pdf
* Arrived as a Received file in FY21 in February 2021
Displays all core courses, by staff member, and building
Report contains instructions and ODE contact information

See EMIS Validation and Report Explanations > File Descriptions on the ODE
website for additional information

ESSA requires schools and programs receiving Title | funds to ensure that all
teachers and paraprofessionals working in a program supported with these
funds meet applicable State certification and licensure requirements
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TLCS Data Uses, cont’d

TLC data will also be used

* by the ODE Office of Educator Effectiveness to provide districts the
Equitable Access Analysis Tool to use for Title | equity planning
e Contains Percent and FTE of teachers who are not properly certified

e Uses previous year’s data - 2021-2022 reporting will be used by your
district in 2022-2023

* Local _Equity_Analysis_Tool 2021 <IRN>.xlsx
e Populated in ODE’s Forms application for SY2021 in January 2021
* This year, the plan is for districts to access this via the SDC in January

* See EMIS Validation and Report Explanations > File Descriptions on the ODE
website for additional information

e Questions — equity@education.ohio.gov
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TLC Status Report

To access the TLC Status Report, select the Level 2 Reports link
from the Staff and Course Collection — Initial (FY22)

Staff and Course Collection - Initial (FY22)

Fr22-L-Stf Crs Init: Collection required for all EMIS reporting entities, The initial staff collection includes staff employed any time in FY22 and st... |

Submissions: September 23, 2021 - January 28, 2022 (71 days &l close)

! Wersion: 1 From OQE: Level 2 Beports
N | Status: The collection was submittad Movember 05, 2021 at 03:55:15 PM by

i { Submission Status: Proceszing Completed (November 05, 2021 a2t 02:55:22 PM)
1 ! Submission Number: 2 (attempt 2

Actions: Start Collaction Prepare Outputs;

&dd Mew Schedulad Collaction

Zat Default Collection properties

View submission 3 Data >

e

\ EMIS
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But first, let’s take a quick look here




" View Submission Data > Generate Review Data

Verify data in the Initial Staff and Course Collection

Generate Review D7
Are there invalid records that need to s ——
. . . . ubmission
= be corrected? Review Level 1 Validations. |
"‘ Career-Technical Education Correlated Class Record (CV).csv 0 0 0 | 0
| Contract Only Staff Record (CC).csv 0 0 0 | 0
Contractor Staff Employment Record (Cl) csv ‘U 0 | 0
Course Master Record (CN).cov Are there Excluded Records —22{ * p>*f | 0
' Excluded_Records.csv . 111 | |
Mapped Classroom Code Record (CM).csy that are preventlng data 0 /‘ 0 | 0
Staff Course Record (CU).csv from being reported? /3( 3 341 | 0
Staff Demographic Record (CI).csv 115 3 118 | 0
Staff Employment Record (CK).csv 171 3 174 | 0
Staff Missi Override R d (CP).csv . N " 0 0 | 1]
e e | Are there missing staff records? T——., |
i g_Report.csv
Staff Summer Employment Separation Record (CL).csv 0 0 0 | 0
Student Course Record (GN).csv 0148 24 5172 | 0
2 34 |625'§‘
Incorrect data = Incorrect TLC Report s
; e S
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TLC Status Report - Level 2

Collection Requests Collection Status Submissions Progress Reports Archives Messages Resources Preferences

— . 0 0

Data Feedback Reports and Files

Pre-Submission to ODE [ Post-Submissipra
Lexel 1 Details I Mighlights and Recent |

Level 2 Detalls

Choose the filter criteria then click the Show Reports link to generate the list of Level 2 reports matching these criteria. To see the option to Generate a single .zip file for all
reports (.csv), you must select a single Report Name, or select a single LEA and a single Collection Request or a single Category.

LEA: v Collection Req :| FY22-L-Stf Crs Init v Data Set: Al v School Year: Al v Category: All v

LEA IRN: Report N (TLCS-001) Teacher Licens: v Last Activity Within: Al v Show closed collections
Processed on or after: Last Updated on or after: mm/dd/yyyy
With Data Only: Exclude reports with 0 rows Report Name includes:

Display Options

Group By: ® Collection Request O LtEA O Level 2 Report O Category O Data set O None File Format: ® coy () wrme

Collection Request / Report Name Fatal Critical Warmm Info Total Category Process Date Last Upd Date Submission Help Page

W Staff and Course Collection - Initial (FY22) (2022L1STR)

(IACS:-001) Teacher 67 s 0 3286 2358 Staff L 12/05/21 09:03 12/05/21 09:03 pyot Koows Helo ..
Qurse Status

Generate 2 sinolezip file for all reports | Exoot cenort information 1o 3 S8y
ENITS

*.
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Formatting the TLC Status Report

* Open the (TLCS-001) Teacher Licensure Course Status Report
* Wrap text header row
* Freeze top row
* Expand all columns
* Apply filters
 Better yet, use your macro!



Quick Check

The TLC Status Report is
updated nightly and should
be reviewed throughout the
Initial Staff and Course
Collection. Data on your
report could appear based on
another entity’s reporting, so
review the report even when
you are not reporting any
changes.

* Are you using the most recent
version of the report?

* Have you corrected Level 1
Validation errors, excluded
records, and missing staff?

* Are you able to open and format
your TLC Status report?
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Understanding
the TLC Status Report
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TLC Status Report Data

e Data from the following collections are used to generate the TLC

Status Report

 Staff and Course (L) Collection - Initial

* Final Calendar (C) Collection

e Beginning of Year Student (S) Collection

| * Midyear Student (S) Collection

| e SOES Beginning of Year Student (S) Collection
 SOES End of Year Student (S) Collection

* Verify data is correct and com

* Report is generated nightly wi
the Initial Staff and Course Co

nlete in ALL noted collections
th data submitted by 5pm throughout

lection

* The TLC Status Report is finalized at the close of the Initial Staff and

Course (L) Collection
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" TLC Status Report Data

Contains one row per Local Classroom Code
* First 11 columns include:

 Teacher of Record and State Staff ID

state staff ID

Location IRN of the building where the course is being taught
Subject Code, Description, and Local Classroom Code

Blank or incorrect staff name could be due to upper- and lower-case letters in

O = O W oW

RPT DEST
IRMN
404040
404040
404040
404040
404040
404040
404040

* Create helpdesk ticket to ask ODE about blank or missing names if needed

B C

- | LOC IRE ~ LOCATION NAME -

222222 High School
222222 High School
222222 High S5chool
222222 High School
222222 High School
222222 High School
222222 High School

D E F G5 H | J K

SEVERITY SUBICT TCHR STATE LAST FIRST MIDDLE
CODE |~|CODE|~|SUBICT DESCR - ID - | NAN ~ | NAN ~ | NAME ~ | LOCAL CLASSRM CODE |~
F "080200 Physical Education OH3005581 Last First 10-1891-1
F '252525 Career Based Intervention NY1000316 Last First ’10-322 1-1
F 252525 Career Based Intervention NY1000316 Last  First "10-8221-2
F '252525 Career Based Intervention NY1000316 Last First ’10-322 1-3
F 252525 Career Based Intervention NY1000316 Last  First "10-8221-4
- . : - : 10-8236-1
i . . . . 10-8236-2

Severity Codes align with Result Codes which ENAIS

[ ] [ ] [ ] [ ] [ ]
will be discussed in upcoming slides a1 e
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- Verifty Staff and Courses

\ * Do not focus on errors only; review the entire report for accuracy and
 completeness
* Are all building IRNs appearing on the report?
* Are all teaching staff appearing as they should?
* Are all courses for each building appearing on the report?

* Remember that total courses are the denominator for Local Report Card
staff percentages, so it’s important that every course is accounted for

A e <</ o E F G H ! ) K
} RPT DEST SEVERITY SUBICT TCHR STATE LAST FIRST | MIDDLE
| 1 IRN ~ LOC IRN ~ LOCATION NAME ~ LODE ~ CODE ~ SUBICT DESCR ~ 1ID ~ NAN ~ NAN -] NAME ~ JLOCAL CLASSRM CODE  ~
2 404040 | 222222 High School F "080300 Physical Education OH3005581 Last First 10-1891-1
‘ 3 404040 | 222222 High School F 252525 Career Based Intervention NY1000316 Last First [10-8221-1
o 4 404040 | 222222 High School F 252525 Career Based Intervention NY1000316 Last First [10-8221-2
W S 404040 | 222222 High School - 252525 Career Based Intervention NY1000316 Last First [10-8221-3
| R 6 404040 | 222222 High School F "252525 Career Based Intervention NY1000316 Last First (10-8221-4
\ 7 404040 | 222222 High School F 252525 Career Based Intervention NY1000316 Last First 10-8236-1
\ 8 404040 || 222222 High School F 252525 Career Based Intervention NY1000316 Last First %-8236-2
e EMI
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} Teacher of Record

* The teacher who appears on the TLC Status Report is based on
e Teacher with greater amount of time teaching the course

* Multiple teachers teaching the same amount of time
* Uses first teacher the report finds who is properly certified
* If none are properly certified the first teacher on the course will appear

» * No proper credential found
| * Uses first teacher reported on the course

* See ODE ITC EMIS Training November 2021 for additional
information

* https://education.ohio.gov/Topics/Data/EMIS/Resources-for-EMIS-
Professionals/EMIS-Training
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Course and Calendar Dates

e Dates are used to determine a “course calendar”
e Grade Schedule (DL) Record - First and Last Day of School
* Course Master (CN) Record - Course Start and End Date
 Staff Course (CU) Record - Staff Course Start and End Dates
e Student Course (GN) Record - Course Enrollment Start and End Date

* The “course calendar” is then used to determine
» Teacher who was with the course the longest
e Students who are counted as being in the class

* Misaligned dates can cause teachers to appear as not properly certified

EMIS
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Location IRN

The building IRN where course is being taught

* District IRN should not be reported as the Location IRN
* Applies to LEAs that have both district and building IRNs

* Refer to reporting instructions in the EMIS Manual for Location IRN
in section 4.2 Course Master (CN) Record

* Filter TLC Report for Location IRN

* Unselect local building IRNs
* Verify Location IRN’s reported outside of District
 Local district IRN should be changed to building IRN (when applicable)

EMIS
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} Location IRN

A few exceptions (not a complete list)

* IRN of college who is granting credit for CCP course

* For CCP Course with delivery method of CP report the IRN of the
location of the course per the CTE-26

* IRN of the location of the JVSD satellite course
* IRN of the building associated with the preschool license

* See additional reporting instructions for the Location IRN in the 4.2
Course Master (CN) Record section of the EMIS Manual

EMIS
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‘\ TLC Status Report Co

lumns

' Moving to the right, the next set of columns L through P contain

|/
1| |

e Result Codes with Descriptions
* Proper Certification Flag (Yes or No)

* Calculated TLC IRN (derived from reported data)

* LEA IRN (IRN of the LEA reporting the course)

| [ O Q 1 5 T
PROPER DLVR ECHUC
RESLILT CERT CALC TLL CHOLILM METHOD QPTION STENT
CODE = RESULT CODE DESCR = |FLAG | = IRMN = LEAIR =] CODE - CODE - |CODE - POPCOL~-
TLOODL Course s Properly Certified and 5 a core course ¥ 222222 404040 OT FF MO Riz
TLODO1 Course is Properly Certified and is a core course ¥ 233323 404040 01 FF [0 ARG
TLO001 Course is Properly Certified and Is a core course '1' 223232 404040 OT FF [ ARG
TLO0DL Course s Properly Certified and s a core course ¥ 222222 404040 OT FF MO Rz
TLOOO1 Course is Properly Certified and 15 a core course L 221233 404040 OT FF RO R
TLO001 Course is Properly Certified and is a core course L 223233 404040 OT FF [0 A&
TLO0D1 Course s Properly Certified and |5 a core course k) 222222 404040 OT FF MO Rz
TLOO01 Cowurse is Properly Certified and is & core course b 222222 404040 OT FF RO Riz
EMIS
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TLC Status Report Columns, cont’d

- Course elements — appear on the report for ease in troubleshooting
* Curriculum Code
* Delivery Method Code
* Education Options Code

e Student Population - Population of students for whom the curriculum is intended
and not about the students who are actually enrolled

L M N 0] P Q R S T
j
[ PROPER DLVR EDUC
‘: RESULT CERT CALCTLC CRCULM METHOD OPTION STDNT
CODE ~ | RESULT CODE DESCR ~ | FLAG |~ | IRN ~|LEA IR~ ]CODE |~ CODE |~ CODE ~ | POPCOIl~
TLOOO1 Course is Properly Certified and is a core course Y 222222 404040 OT FF NO RG
TLOOO1 Course is Properly Certified and is a core course Y 222222 404040 OT FF NO RG
TLODO1 Course is Properly Certified and is a core course Y 222222 404040 0T FF NO RG
TLOOO1 Course is Properly Certified and is a core course Y 222222 404040 OT FF NO RG
TLOOO1 Course is Properly Certified and is a core course Y 222222 404040 OT FF NO RG
TLOOO1 Course is Properly Certified and is a core course Y 222222 404040 OT FF NO RG
TLOOO1 Course is Properly Certified and is a core course Y 222222 404040 OT FF NO RG
TLOOO1 Course is Properly Certified and is a core course Y 222222 404040 OT FF NO RG
\ EMIS
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Special Ed vs Regular Student Population

Student population reported based on the content of the course
e If modified for special education population, report with an SE

student population
| e Teacher must hold a special education license to appear as properly certified
| for an SE course
e Certification and Licensure Search does not include courses coded with a
student population = SE
| e If not modified for special education population, report with an RG

student population
e Teacher must hold a regular education license to appear as properly certified
for an RG course

EMIS
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TLC Status Report Columns, cont’d

Columns U through AJ contain

e Count of students enrolled in the course by state equivalent grade
level (both regular education and students with disabilities)

E 5 T v W ¥ Y K A4 AB AC AD AE AF AG AH Al )
| TWENTY
| : FIRST SEC THIRD FOURTH FIFTH SIXTH SEVNTH EIGHTH NINTH TENTH ELVNTH TWELTH THRTNTH THIRD

i ; DLVR EDUC KDG  GRADE GRADE GRADE GRADE GRADE GRADE GRADE GRADE GRADE GRADE GRADE GRADE GRADE  GRADE
i METHOD OPTION STDNT PS STDNT STDNT STDNT STDNT STDNT STDNT  STDNT STDNT STDNT STDNT STDNT STDNT STDNT STDNT  STDNT  STDNT
1 CODE |~ | CODE|~ POPCOl~ | COUNT ~| COUR ~ | COUR ~ COUF ~ | COUR ~ COUN ~ | COUR ~ | COUF ~ | COUN ~ | COUN ~ | COUR ~ | COUP ~ | COUN ~ | COUN| ~  COUNT ~ | COUN] ~

92 FF MO RG 0 0 0 0 0 ] 0 0 0 a 0 0 24 0 0 0
93 FF MNO Ris 0 0 ] 0 ] 0 0 0 O 0 0 0 21 1 0 0
94 FF MO RG 0 Q0 0 0 0 0 0 0 0 Q 28 0 0 0 0 0
95 |FF MO Rz o 0 0] 0 ] 0 0 0 0 0 18 0 o 0 0 o

== . = = = = = = = = == 0 ) 0 Q0 )
Cells can be blank if there are no students enrolled in the cours g g g g g
Or the students are not being populated onto the report

EMIS
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TLC Status Report Columns, cont’d

Far right columns contain

* Counts of students with disabilities and the percentage of those students

in the course

* Credential Course Disability Indicator Code with Description

* Reported TLC IRN, Check Type Code and Provider IRN

AK Al AM AN AO AP AQ AR
CRED

DISAB COURSE CHECK

STDNT TOTAL DISAB IND RPTDTLC TYPE PRVDR ERRSEV

COUr ~ DISAB Pt~ CODE  ~ CRED COURSE DISAB IND DESCR - IRN ~ CODI~ IRN ~ NUM ~
5 2083 2 Student Population of PR or RG. 222222iIR 2 |oOnOeS 15
3 13.64 Z Student Population of PR or RG. 2222221R  |YOUWeR 15
0 02z Student Population of PR or RG. S22 [T 15
3 16.67 Z Student Population of PR or RG. 2222221R  |*ReeS 15
2 11.76 Z Student Population of PR or RG. 222222i1R  |*o%*® 15
0 02 Student Population of PR or RG. 222222IR | |9°"O%® 15
0 02 Student Population of PR or RG. 222022IR 2 |ReeN 15
3 13.64 Z Student Population of PR or RG. 222222IR  |[teeNen 15

ERR SEV NUM

aligns with the
Severity Code,
in column D

EMIS
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Reported TLC IRN

* IRN of the building where this course will be used in the
calculation of the percentage of core courses taught by
properly certified/licensed staff

* Local, exempted village, or city school districts can report the
IRN of one of their own buildings but should not report their
district IRN for the TLC IRN

* Refer to EMIS Manual 4.3 Staff Course (CU) Record to review
all reporting instructions for this element



- Core or Non-core?

l~ ° . [ ] L]
- EMIS Manual section 4.7 Subject Codes  |A value in this column
“ I i ) . ] [ [
! L Department 4.7 Sub Code:
\\,\ | Oth | of Education i Indlcates CORE SUbjeCt
| : (] 14
, . . area while “—
Business Education Section . d .
indi non-Cor
Table 5. Business Education (Non-Career Technical) Codes (03xxxx) Z Cates d 0 CO €
Subject | Description Suggested || Core Subject H
Code Subject Area (for su bJECt COde
‘ Area for | proper cert)
| Credit
Accounting BUS -
Instruction focuses on the management of a company’s financial re- L - H
sources including the accounting cycle, financial statements, and in- \ Non Core su b.'ECt COde
030100 |terpretation and use of financial data. Content should be based on
i; National Business Education Association (NBEA) content standards.
’ Only grade 9-12 courses based on standards from the 9-12 grade

I band of NBEA Standards are eligible for high school credit.
! Business Mathematics

BUS, MTH| Mathematics ¥+ .
Students develop the skills necessary to solve mathematical prob- CO re su bjECt COd es

lems, analyze and interpret data, and apply sound decision-making
030500 |skills in business. Content should be based on National Business Ed-
ucation Association (NBEA) content standards. Only grade 9-12
courses based on standards from the 9-12 grade band of NBEA
Standards are eligible for high school credit.

Business Communications

Students master the oral and written communication skills essential
to interacting effectively with people in the workplace and society. EMIS

030600 | Content should be based National Business Education Associa- N
\ 306 ontent should be based on National Business Education Associa .ﬁ‘ e

Alliance
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Reported TLC IRN, cont’d

e Report ****** for non-core courses and for core courses where

e Curriculum element s

* OC — Expert Contracted from Outside Company/Organization for Credit Flex,
PS- College Credit Plus, or Pl — Postsecondary Instructor (not CCP)

 or Delivery Method is

 CC—Correspondence Course, ET — Educational Travel, or OL - Online, and
Educational Option is Yes

* or Delivery Method is

* ID — Interactive Distance Learning, IM — Internship/Mentorship, TO — Test Out,
or Cl — Computer as Instructor

e or Student Population is

D8 — Preschool Special Education, DP — Preschool Special Education
Hearing/Visual, or PR — Preschool General Education

EMIS
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Reported TLC IRN, cont’d

* When contracting a teacher of record from an EMIS reporting
entity

* Two common situations-

* Contracted teacher is teaching only your students in a
course in your building

* Report the building IRN as the TLC IRN (same as Location IRN)

* Contracted teacher is teaching students from multiple

districts

* Report the district IRN of the contracted entity (Location IRN is
building where class is being taught)

* See 4.3 Staff Course (CU) Record section of the EMIS Manual
for additional reporting instructions

EMIS
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. Reported TLC IRN, cont’d

* Courses reported with a TLC IRN of another EMIS Reporting
LEA should appear on both LEA’s TLC Status Reports when
reported correctly

e Contractor Staff Employment (CJ) Records are required to
| be reported by the entity employing the staff member but
are not needed for the course and staff to appear on both
contracted entity’s TLC Status report

* Work with contracted EMIS Reporting entities to verify that
teachers and their courses are appearing correctly



Staff Provider IRN

Reported on the Staff Course (CU) Record

e District IRN of the EMIS Reporting entity who employs the contracted
staff

e Cannot be an IRN of a Non-EMIS Reporting entity

e Should be reported as ****** jf the staff member is not being
contracted from another EMIS reporting entity

* Must be reported when the entity reporting the course is not
reporting Staff Demographic (Cl) and Staff Employment (CK) records
for the staff member

* Filter on Staff Provider IRN to verify accuracy of reporting

EMIS
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Derived Elements on TLC Status Report

e Calculated TLC IRN

* In most cases the calculated TLC IRN will match the TLC IRN reported for
core courses

e could be set to match the Location IRN when TLC IRN is reported as
kxxkx* or reported with an IRN that is not a valid public school

* non-core courses will be set to ******

* Credential Course Disability Indicator

 derived from reported student population and students with disabilities
who are enrolled in the course

e are used to determine the Check Type
* Check Type Code

e indicates the credential check that was used

EMIS
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Credential Course Disability Indicator A

Filter on A - Student Population of DP or SP

* DP-Preschool Special Education Hearing/Visual
» SP-Special Education K-12 Hearing/Visual

| * More than 50% of the students in the course must have a disability
| condition
* Of these students, more than 50% must have a disability condition of

e 1 (Multiple Disabilities-Other than Deaf-Blind)

e 2 (Deaf-Blindness)

e 3 (Deafness-Hearing Impaired)

* Can be all 3s or some combination of these three disability conditions

e Check Type Code is S — Special Situation Check

EMIS
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Credential Course Disability Indicator B

Filter on B - Student Population of DP or SP

* DP-Preschool Special Education Hearing/Visual
» SP-Special Education K-12 Hearing/Visual

* More than 50% of the students in the course must have a disability
| condition
* Of these students, more than 50% must have a disability condition of
e 1 (Multiple Disabilities-Other than Deaf-Blind)
* 2 (Deaf-Blindness)
* 4 (Visual Impairments)
* can be all 4s or some combination of these three disability conditions

e Check Type Code is S — Special Situation Check

EMIS
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Credential Course Disability Indicator C

Filter on C - Student Population of D8 or SE
* D8 - Preschool Special Education
* SE - Special Education K-12
* More than 50% of the students enrolled in the course must have a
disability condition
* Course cannot fit into codes A or B
* Check Type Code is S — Special Situation Check

EMIS

ol [y

! -»
Alliance



Credential Course Disability Indicator D

Filter on D - Student Population of DP, D8, SE, or SP

* DP - Preschool Special Education Hearing/Visual

* D8 - Preschool Special Education

 SE - Special Education K-12
» * SP- Special Education K-12 Hearing/Visual
| * 50% or fewer of the students enrolled in the course have a

disability condition
* Check Type Code is R — Regular Check

EMIS
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Credential Course Disability Indicators E and Z

Filter on E - Student Population of GA or GE
* GA - Gifted Education in arts delivered by trained arts instructor K-12
e GE — Gifted Education K-12
* Check Type Code is S — Special Situation Check

Filter on Z - Student Population of PR or RG
* PR —Preschool General Education
* RG — Regular/General Education
* Check Type Code is R — Regular Check

Filter on X — Does not fit into categories A, B, C,D, E, or Z
* Rare
* Means none of the above
 Verify proper certification flag has been set properly

EMIS
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FY21 Check Type Code F - No Longer Applicable

For FY21 due to COVID related school closures, flexibility was put

in place to allow teachers to teach outside their subject area and
grade range

* That flexibility is not in place for FY22

22-1 Reverse COVID-related temporary license Teacher Licensure Course Status Report change.  State law
Staff/Course HB 197 allowed the Department to issue temporary versions of licenses, which were

Sep#2 treated as full licenses in FY21 only. This change reverses EMIS change 21-45.

Completed

First posted: 11/16/20
Completed: 9/23/21

EMIS
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Regular Check Type Code R

Filter on R — Regular Check

* Majority of courses
e Educational Option = No
» Student Population
* RG - Regular/General Students K-12
* PR —Preschool General Education
* Delivery Method = FF — Face to Face and OL — Online
* Curriculum code
* AP — Advanced Placement
* |A—International Baccalaureate AB INITO
e OT — Curriculum not specifically covered by another option

e Career Tech Codes
EMIS
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} Special Situation Check Type Code S

Filter on S — Special Situation Check
* Educational Option = No

e Student Population
| * DP - Preschool Special Education Hearing/Visual
P * D8 - Preschool Special Education
‘ * GA - Gifted Education in arts delivered by trained arts instructor K-12
* GE - Gifted Education K-12
e SE - Special Education K-12
* SP - Special Education K-12 Hearing/Visual

EMIS
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Any Certification Check Type Code A or N

Filter on A — Any Certification Check
* Educational Option = YS *OR*

* Delivery Method of
* Cl — Computer as Instructor
* |[D — Interactive Distance Learning
| * IM — Internship/Mentorship
} Filter on N — No check required
| e Courses with Curriculum Element
e OC — Expert Contracted from Outside Company/Organization for Credit Flex
* Pl - Postsecondary Instructor
e PS —College Credit Plus

* Educational Options = YS

e Delivery Method =TO, ET, IS, IM, OT (community service, work-based
learning) EMIS
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Community School Check Type Code C

Filter on C — Community School Course

* Traditional district regular checks are run and if the Properly
Certified Flag is set to N, additional checks are run that allow for any
regular teaching license or any substitute license that is not a Short-
Term Substitute license

* This does not apply to special education checks

* A Short-Term substitute license will never be considered as properly
certified

EMIS
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Quick Check

The TLC Status Report uses a
wide variety of data from
many different collections.
Taking time to verify that
EMIS data is correctly
reported will result in a
clearer, more accurate TLC
Status Report.

* Have you reviewed your EMIS data
for accuracy and completeness?

 Are all courses and teaching staff
appearing on the report?

* Have you shared the data with
staff who can assist with data
verification?

EMIS
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CORE Educator Search
and Certification and
Licensure Search
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CORE Database

The TLC Status Report

* looks at each course and at data regarding the teacher’s current
credentials from the CORE database

» determines if the staff member is appropriately credentialed to
teach the
* subject code
» student population
» grade level(s) of the students scheduled in the course

e Use the CORE Database/Educator Search to review teacher
licensure information

EMIS
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-~ Educator Profile Search

https://core.ode.state.oh.us/Core4/ODE.CORE.Lic.Profile.Public.Ul/

OME ABOUT ODE STATE AGENCIES _ ONLINE SERVICES (Ohio oV
| - Department 9
‘ Ohlo ! of Education > LOGIN Jsion Timeout:00:29:46

EDUCATOR PROFILE ~ EDUCATOR CONDUCT SEARCH COPRT Tiomt

;'

Access publicly from
this page or click either
link to log into OH|ID

ator Prohile. To view your det 0 acceass your CORE dashboa
to access the CORE App

Q Educator Search

Educator State 1D: Last Name: First Name: Middie Name: Birth Year:

Educator Profile

CORE App

Educator Licensure and ducator
Records (CORE)
Apply, renew, and maintain licenses EMIS
L /3
NS 45
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Demographic Information

2 Educator

Copy Educator Info 8 | Print Educator Summary 1=

Educator State 1D: Full Hame: Birth Year:
O 1074
Credentials are listed along with

# Credentials additional information below

g +4 CREDENTIAL L STATUS _ ~ EFFECTIVE DATE ISSUE DATE EXPIRATION DATE CREDE
= | 5 Year Professional High School (7-12) License 070172018 05/132018 06/30/2023 21538538

| | Teaching Fields Issue Date

i General Science [130100] 05/132018

1‘ y = 5 Year Professional High School (7-12) License 0710172013 0472572013 06/30/2018 20870234

J'l .E Teaching Fields Issue Date

| General Science [130100] 04/25/2013

| | Note the active license/certification 07/01/2008 03202008 06/30/2013 20199075
/2 || and teaching fields L —_

*»; \ ."':%‘ 46
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\‘ Educator Credential Data by District

;
i

In the Educator Profile dropdown menu,
SEIeCt Educator Data by DiStriCt HOME ABOUT ODE  STATE AGENCIES  ONLINE

Oh - Department
10 | o Education 4

EDUCATOR PROFILE EDUCATOR CONDUCT SEARCH CORE HOME

» Educator Search

» Esigner Data Search

ial Data by District

» Educator Data by Dist

Re

9 Final Staff Course Collection Latest Version

f Organization Search

! Organization Name or IRN:

UaiE02 - Columbus City School Distnct - Public Distnct el S Res
e R L \ Choose a school and then
Start Typing Either an Organization Mame or IRMN and Click on "Selact’ “SEIeCt” to download a /
spreadsheet of educator data

\\ "ss
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Teacher with Two Licenses

® Credentials
+ CREDENTIAL STATUS EFFECTIVE DATE ISSUE DATE EXPIRATION DATE CREDENTIAL NUMBER ‘
= 1 Year Supplemental Adolescence to Young Adult (7-12) License 07/01/2019 07/07/2019  06/30/2020 21741573 ‘
I Valid In Organization: Akron Cxtz [043489|I
Teaching Fields Issue Date H -
Integrated Social Studies [150004] 07/07/2019 Thls teaCher has aone yea r
Limitations Issue Date 1 1 1A 1
Limited To 2 Renewals [888002] 07/07/2019 Ilcense that IS Only Valld In
= 5 Year Professional Comprehensive High School (7-12) License m 07/01/2018 02/02 thls d lStrICt das WE" as d 5
Teaching Fields Issue Date yea r |IcenSe
All Social Studies 7-8 [150310] 02/02/2018 T
History (9-12) [150805] 02/02/201
Political Science (9-12) [151110] 021022014 Note any |imitations’ teaching
5 Year Pupil Activity N/A Permit Issued 07/01/2017 .
=3 fields, or endorsements that
= 5 Year Professional Comprehensive High School (7-12) License 07/01/2013 .
may be listed
Teaching Fields Issue Date
All Social Studies 7-8 [150310] 07/06/2013
History (9-12) [150805) 07/06/2013
Political Science (9-12) [151110] 07/06/2013

EMIS
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Certification and Licensure Search

e

Home > Data > EMIS > Certification and Licensure

QUICK LINKS

» EMIS Basics
» Documentation

» EMIS Reporting Responsibilities

READ ME
Certification and Licensure Search

Office of Educator Licensure
614-466-3593 or 877-644-6338
educator.licensure@education.ohio.gov

This resource was created to assist districts in validating data that appear on the Teacher

Licensure Course (TLC) Status Report generated by EMIS. For a list of the current subject codes
please see EMIS Manual Section 4.7. This search has been updated for FY22.

» Resources

» EMIS Technical Documen Llnk 2

Search for Regular Teaching Certificates and Licenses

5t

» EMIS Advisory Council

» EMIS Learning Library

» Certification and Licensure Search
» SLDS Grant Project 3

P S g -

EMIS Newsflash - December 1,
2021

EMIS Newsflash - November 19

. Link 1

This search is for situations where a course master has been submitted and the student
population is PR or RG (i.e., regular education courses). Every permissible combination is not

Student Population
PR - Preschool General Education
RG — Regular/General Students K-12

found in this search. For instance, situations in which a teacher is required to have multiple

teaching fields or multiple credentials do not appear.

Note that the general rule for elementary credentials (i.e., Kindergarten-Primary (KP),
Kindergarten-Elementary (KE), Elementary (EL), Early Childhood (EC)) allows the teachers who
hold these credentials to teach any course within the relevant grade range. These situations
are not reflected within this search tool. An exception to this rule is for those initially hired on
or after July 1, 2013, to teach physical education. These teachers must be licensed in PE and ar¢
included in this search tool.

For questions regarding Invalid_Cert reports, please contact EMIS via the helpdesk. For
questions regarding teacher assignments, please contact the Office of Educator Licensure.

OR

Search for Special Education Teaching Certificates and Licenses

EMIS Newsflash - November 11,
2021

This section is for courses reported with student populations of DP, D8, GA, GE, SE, and SP (i.e.,

special education courses).

Student Population

DP - Preschool Special Education
Hearing/Visual

D8 — Preschool Special Education
GA - Gifted Education in Arts...K-12
GE - Gifted Education K-12

SE — Special Education K-12

SP — Special Education K-12
Hearing/Visual

EMIS
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Link 1 — Special Education

Special Education Certification Information

hio.gov | Jepartment - Student Population

Home > Data > EMIS > Certification and Licensure Search > Teaching SE - SpECiaI Education K-12
> Regular Course Search Panter Friendly Version . .
T READ ME SP — Special Education K-12
Qe — Special Education Teaching Certificate & License Search Hea rlng/V|suaI

(for courses with student populations of SE or SP) <

About ODE
State Board of Education This section is for those teachers reported with position code 230 and assignment area 999414 <
Media

Assighment area 999414
General Rule: Any teacher holding an education of the handicapped certificate (EH) or an intervention specialist
license (IL or ES) can teach students—at the grade levels for which the teacher is certificated or licensed—with any

i Special Education K-12

"Exceptions:

= Any SE or SP course that is comprised of g/l hearing impaired students must be taught by someone certificated
or licensed to teach hearing impaired students. This includes the following

EH 196010, 19€015, 196070 (grades K-12)

IL 196116 (grades P-12) \ General RUIe

[ ]
Any SE or SP course that is comprised of alf visually impaired students must be taught by someone certificated a n d EXCE pth n S
or licensed to teach visually impaired students. This includes the following

EE 196110 (grades K-12) /

EMIS
IL 196109 (grades P-12) !

;N\
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Link 2 - Teaching Certificate & License Search

Click on the Cert/Lic. Type link License Types

i

to see a Ilst of Llcense Types AD  Adolescence to Young Adult (7-12)
. D t AE Adult Education
epartmen HPH H Al Ed | Ald
Ohio.govV | o Eaeaton (this is not a complete list) il i
_ Home > Data > EMIS > Certification and Licensure Search > Teaching AM  Student Monitor
_— .| AS  Administrative Specialist
> Regular Course Search Printer Friendly Versig AT  Technologist
. CheckType: 0
>Spocid5dl.:aion ' AU  School Audiologist
- Teaching Certificate & Licens¢ Search - e
& SAFE ACCOUNT SIGN IN BM  EAS - Business Management
These are individuals for whom a course master ha ed, i.e., with ppsition code 230 and assignment argl CH  Comprehensive High School (7-12)
About ODE 999370 or 999300. CR  EAS - School-Community Relations
: CT Career Technical (4-12)
State Board of Education
Media ; - arch for Valid Subjects by CW  Career Technical Workforce Development
; : : DS  Designated Subject (Grades K-12)
Search for Valid Certificates/Licenses b / l Select Type Vl DS  Designated Subject (4-12)
EA  EAS - Educational Staff Personnel Administration
] OR & Codes (up to 6): \ EC  Early Childhood (P-3)
ED  EAS - Educational Personnel
: EH  Education of the Handicapped (K-12)
Submit EL  Elementary (1-8)
o Submit EP Elementary Principal (K-8)
999370 - General EducatIOH K'].Z ER EAS - Educational Research
o ES  Early Childhood Intervention Specialist (P-3)
and 999800 Career-Technical GE__General Education
ent of Public Instruction | Contact ODE | Ohio Home |
| Programs/Career Pathways EMIS

| e
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Search for Valid Subjects

Search by Certification/
1 . .
| e e Teaching Certificate & License Search License Type and Teaching
| These are individuals for whom a course master has been submitted, |.e., with position code 230 and assign FiEIdS and Endorsements
About COE 99370 or 999800

Media | Search for Valid Subjects by /

Search for Valid Certificates/Licenses by

Subject Code (EMIS Manual Section 4.7): Cert/Lic. Type:| AD v 1/
| OR & Codes (up to 6): | 150004

| Submit |
mSubmnM |

o Results are a |I.St of su!o;ec.t codes and
T T grades that this combination of
| 150004 Certification/License Type and codes

, is properly certified to teach
e SuectCode(s) 'A Grace(s)
FbO"‘" exceplions may exist. Chck Her Pr {0\ ."vé'-': ihese
exrem"‘“
‘ 031800 | 7-12 EMIS
150100 ' 7-12 '

)
.@' 59
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Search for Valid Certificates/Licenses

. SAFE ACCOUNT SIGN IN

About ODE
State Board of Education
Media

Teaching Certificate & License Search

These are individuals for whom a course master has been submitted. i.e., with position code 230 and assignment
area 999370 or 999300.

Search for Valid Subjects by

Search for Valid Certificates/Licenses by !
Subject Code (EMIS Manual Section 4.7): Cert./Lic. Type: |Select Type V|

Search by

Subject Code

& Codes (up to 6):
132130 OR
/ Submit

Results are lists of certificates/licenses

that can teach this subject code

along with teaching fields and grade levels

‘Subject Code:

Cert. Type Cert. Code(s) Grade(s) Lic. Type Lic. Code(s) Grade(s)
Some exceptions may exist. Click Here to view these Some exceptions may exist. Click Here to view these
exceptions exceptions

CH 130175 7-8 AD 130100 7-12
HS 130000 7-12 AD 132010 7-12
HS 130100 7-12 AD 132020 7-12
HS 130200 7-12 AD 132030 7-12
HS 130301 7-12 AD 132034 7-12




Quick Check

The TLC Status Report checks
against the CORE database to
determine if a teacher is
properly certified to teach a
specific course. Searching the
database can aid in
troubleshooting the report.

* Are you able to use the CORE
Educator Search Tool to view
certification data?

* Can you search using the
Certification and Licensure Search
by certification or subject code?

* Are you involving your district’s
Human Resources staff in this
process?

EMIS
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TLC Status Report Result Codes
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- Properly Certified Result Codes

* Filter on TLC Result Code TLO0O1 (Informational)

* Core Course
* Proper Cert Flag =Y

. * Filter on TLC Result Code TL0002 (Informational)

| * Not Core Course
* Proper Cert Flag=Y

* Verify the data to be correct and complete



Not Properly Certified - No Students in Course

Filter on TLC Result Code TLOOO5 (Critical)

e Student Grade Count columns for this course will contain blank
values

* Verify that no students are enrolled in the course
* These courses will not negatively impact the LRC and can be reported,
however, the row will remain as a critical

* These courses could negatively impact CTE funding. If this is a future term
course, schedule students into the course or you will need to request an
override from CTE if it is not CTE FTE funded

EMIS
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Not Properly Certified - No Students in Course, cont’d

Continue filtering on TLC Result Code TLOOO5 (Critical)

* Are there students being reported as enrolled in the course?

* Check the dates to be sure they are aligned
e Calendar start and end dates

e Uses the most common calendar dates for the majority of students in the
course

e Course Master (CN) Record start and end dates
 Staff Course (CU) Record start and end dates
e Student Course (GN) Record enrollment start and end dates

* If there are truly no students enrolled in the course at any point during
the school year and this is not a CTE course, then result code can be
ignored

EMIS
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Not Properly Certified — Credential/Course

No Current Credential or Incorrect Student Population
* Filter on TLC Result Code TLO0OG6 (Fatal)

 Staff not certified to teach this subject code or student
population
e Check certification to see if they can teach the subject code
* Check the student population, is it correct?
* Filter by that staff member to see all courses and student populations to
verify
* Check the students who are enrolled in the course to verify that
they align with the student population element

EMIS
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Not Properly Certified — Credential/Course, cont’d

Could be a career technical course that requires an override
* VM overrides are now automated

* Questions regarding CTE overrides can be sent to
* CTETeacherOverride@education.ohio.gov

* Will continue to be not properly certified on the TLCS Report

EMIS
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Not Properly Certified - Substitute

Substitute Credential for traditional districts

* Filter on TLC Result Code TLO0O07 (Fatal)

* A long-term substitute can appear as properly certified when reported by a
community school

* Any short-term substitute license will never be properly certified

* Substitute teachers who are providing instruction and assigning grades should
be reported as the teacher of record, even if the teacher will be returning

# Credentials Click to Hide =

+i CREDENTIAL STATUS EFFECTIVE DATE ISSUE DATE EXPIRATION DATE CREDENTIAL NUMBER
-| 5 Year Long Term Substitute Multi Age (P-12) License | m 07/01/2018 07/10/2018 06/30/2023 21587622

Teaching Fields Issue Date

French [060230] 07/10/2018

EMIS
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\ Not Properly Certified - Org IRN

Org IRN Not Matching
* Filter on TLC Result Code TL0O0O0S (Fatal)

 Questions about these situations should be directed to the Office of
Educator Licensure

¥ Credentials

+t CREDENTIAL STATUS  EFFECTIVE DATE ISSUE DATE EXPIRATION DATE CREDENTIAL NUMBER
= 4 Year Alternative Resident Educator Designated Subject (Grades K-12) License m 07/01/2019  05/14/2019 06/30/2023 21701337

Valid In Organization: ESC of Central Ohio [046938]

Teaching Fields Issue Date

English [050000] 05/14/2019

Visual Art [020015] 05/14/2019

Alliance
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| Not Properly Certified — Grade Level

}‘i Students Outside Grade Range for Credential
\ * Filter on TLC Result Code TL0O009 (Fatal)

* More than 50% of students enrolled must be within the grade

levels on the teacher’s credential
® Credentials |

e CREDENTIAL STATUS EFFECTIVE DATE ISSUE DATE EXPIRATION DATE CREDENTIAL NUMBER

| = 5 Year Professional Elementary (1-8) License m 07/01/2018 03/22/2018 06/30/2023 21512322 .
These credentials
‘ Endorsements Issue Date
Reading K-12 [059902] 03/22/2018 a I IOW the teacher tO
§ Year Professional Kindergarten-Primary (K-3) License 07/01/2018 03/22/2018 06/30/2023 21512323
[ ]
= 5 Year Professional Elementary (1-8) License  Expirex 07/01/2013 04/26/2013 06/30/2018 20870652 tea C h Stu d e nts I n
Endorsements Issue Date grades K-8
Reading K-12 [059902] 04/07/2014
I 5 Year Professional Kindergarten-Primary (K-3) License 07/01/2013 04/26/2013 06/30/2018 20870651
5 Year Professional Elementary (1-8) License 07/01/2008 04/08/2008 06/30/2013 20213662
5 Year Professional Kindergarten-Primary (K-3) License 07/01/2008 04/08/2008 06/30/2013 20213663
5 Year Professional Elementary (1-8) License 07/01/2003 04/18/2003 06/30/2008 3236647




Not Properly Certified — No Staff Course Record

No Staff Course (CU) Record
* Filter on TLC Result Code TL0O010 (Fatal)

e Teacher will not appear on the TLC Status Report

e Check Level 1 Validations for fatal or dependent errors that could cause
the Staff Course (CU) Record to not be reported

 Check for State Staff IDs that contain lower case letters

* Check for missing CJ records from a contracted staff reporting
relationship

EMIS
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Quick Check

The TLC Status Report
performs teacher certification
checks using your EMIS data,
as well as data from other
LEAs, against the CORE
database. Verify that your
data is correct prior to the
close of the Initial Staff and
Course Collection.

* Are you reviewing the TLC Status
Report regularly?

* Are you reporting data accurately
to EMIS?

* Are you working with district staff
to verify the data?

EMIS
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TLCS Excel Tips




Highlight and Sort

* Review the report by teacher
* Clear all filters
* Sort by Proper Cert Flag column (A-2)
* Highlight all rows with Proper Cert Flag = N
* Sort by Last Name and First Name

* Scroll through report and note-
 Staff member’s courses are showing as properly certified
e Staff member’s courses are showing as not properly certified
(highlighted rows)
 Staff member’s courses are appearing with some courses properly
certified and some not properly certified (highlighted rows)

EMIS
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Pivot Table — Proper Cert Flag by Teacher

Create Full Name Column using Concatenate

* Select co
* Right clic
 Select ce
* Select ce

umn K
kK and select “Insert”
| K1, add title “Full Name”

| K2

e Enter the formula =CONCAT(H2," ", 12, " ", J2)
* Copy formula down (double-click or drag down + in corner of cell)

e Select co
* Right clic
* Right clic

umn K
< and select “Copy”

< again and select - Paste Value 123 icon

EMIS
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- Verify Teacher Course Pivot Table - Proper Cert Flag

Create Pivot Table

* From Insert Tab, select Pivot Filters columns
Table PROPER CERT FLAG ~ ~
e Select OK
| * Pivot Table Fields to select:
| e Columns Rows Values
! * PROPER CERT FLAG TCHR STATE ID » | || Count of TCHR STATE ID ~
* Rows
| * FULL NAME
e Values
e Count of TCHR STATE ID
Defer Layout Update

EMIS
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Verify Teacher Course Pivot Table, cont’d

A B C D

1
2
3 Count of TCHR STATE ID |Column Labels ~
4

Verify Total by Teacher

* Why is the teacher certified : fRowl T s

in some courses but not 6 1999999999 5 17 22

7 |BG1032044 1 1

Othe rS? 8 |BW1000441

9 DF1000541 2

10 |MK1002761 1

* Does the teacher have too N NY1000316

12 |OH1041720

many courses? 13 OH1202130

14 'OH1210909

RS S R N

* Do all teachers appear in the | om0

16 OH12359865

pivot tab|e? 17 |OH1302861

18 |OH1317557 1

19 |OH1318170 1

20 |OH1345628 9

21 0OH1411734 / 1

| |o|k |k | w~ e |w|uv o= e o,

Tip - Add “All Borders” from Home Tab EMIS
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Summary

* The TLC Status Report contains both data to verify and issues
to correct

* Some issues can be corrected, and some are simply stating
the fact

* Work with district staff to verify that the data is both correct
and complete

* “No errors” does not necessarily mean that your data is
complete and accurate

* Use Excel functions to make troubleshooting easier

EMIS
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- Resources

* (TLCS-001) Teacher Licensure Course Status Report
Explanation

e ODE Home > Data > EMIS > Documentation > EMIS Validation and
Report Explanations

e EMIS Manual
e ODE Home > Data > EMIS > Documentation > EMIS Manual

* Credit Flex Information-
http://education.ohio.gov/getattachment/Topics/Ohio-Education-
Options/Credit-Flexibility-Plan/Credit-Flexibility-Guidance-and-
Information-2018.pdf.aspx?lang=en-US

EMIS
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http://education.ohio.gov/getattachment/Topics/Ohio-Education-Options/Credit-Flexibility-Plan/Credit-Flexibility-Guidance-and-Information-2018.pdf.aspx?lang=en-US

-~ Resources, cont’d

* Educator Search
e https://core.ode.state.oh.us/Core4/ODE.CORE.Lic.Profile.Public.Ul/
 OH|ID Portal App - Educator Licensure and Records (CORE)

* Certification and Licensure Dictionary

* https://education.ohio.gov/Topics/Teaching/Licensure/Additional-
Information/Certification-and-Licensure-Dictionary

e Office of Educator Licensure
e 614-466-3593 or 877-644-6338
e educator.licensure@education.ohio.gov

* Your district staff and your ITC

Alliance


https://core.ode.state.oh.us/Core4/ODE.CORE.Lic.Profile.Public.UI/
https://education.ohio.gov/Topics/Teaching/Licensure/Additional-Information/Certification-and-Licensure-Dictionary
mailto:educator.licensure@education.ohio.gov

Questions?

If you would like a certificate of attendance for this
| training, you must complete the below feedback form

within 5 business days of this training
https://tinyurl.com/EA-District-Feedback

\ EMIS
N
| e

Alliance



https://nam04.safelinks.protection.outlook.com/?url=https%3A%2F%2Ftinyurl.com%2FEA-District-Feedback&data=04%7C01%7Ctammyhrosch%40metasolutions.net%7C1ffc7cb91444482682a808d968c965ab%7Ca2b91a638b914657a89212e8f42ed79c%7C0%7C0%7C637656036474783411%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C1000&sdata=%2BLOxwQTPwvKI1G%2FtLDrBW000JdyqS8QPohAjh7llCPE%3D&reserved=0

